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Overview

1 Overview
This documentation describes how to install and use Processor Expert in conjunction with the Gen4eXtremeSwitch component.

The Gen4eXtremeSwitch component supports the following analog parts:

* NXP MC12XSF: External industrial lighting 5 MHz SPI-controlled eXtreme Switch (www.nxp.com/MC12XSF)
+ NXP MC12XS6: External automotive lighting 5 MHz SPI-controlled eXtreme Switch (www.nxp.com/MC12XS6)

NXP’s FRDM-17XSF5-EVB, FRDM-17XSF4-EVB, FRDM-08XSF4-EVB and FRDM-40XSF5-EVB boards are evaluation platforms based
on the MC12XSF and the MC12XS6 devices. See the related user guides and datasheets for detailed information.
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21 Peripheral requirements

Peripherals and resource requirements critical to the MCU’s ability to handle a given part are as follows:

SPI communication mode

SPI module - required for communication (SI, SO, SCLK, CSB pins)

TPM/FTM timer (PWM, single channel) required for clock generation

GPIOs - required for the device reset (RSTB) pin and direct input pins (IN1 through IN4)
ADC and GPIO - required for current sensing (CSNS) and synchronization (CSNS SYNC)

2.2 Supported devices

The 12XSF and 12XS6 families represent the fourth generation of NXP’s eXtreme switch products.This product line supports automotive
and industrial lighting applications ranging from incandescent bulbs to LEDs.

Common features of both the 12XSF and the 12XS6 family are:

Operating voltage range of 7.0 V to 18 V, with sleep current < 5.0 uA

5.0 MHz 16-bit SPI control of overcurrent profiles, channel control including 8-bit PWM duty-cycles, output ON and OFF open load
detections, thermal shutdown and pre-warning, and fault reporting

Output current monitoring with programmable synchronization signal and supply voltage feedback

Programmable overcurrent trip levels

Enhanced output current sense with programmable synchronization signal and battery voltage feedback

Watchdog and limp home mode

External smart power switch control (Output 6)

—16 V reverse polarity and ground disconnect protection

Compatible PCB foot print and SPI software driver among the family

The 12XSF and 12XS6 family products differ in the number of available outputs and their Rpg o) resistance (see Table 1).

Table 1. Device features

Product Number | No. of Outputs ouT1 ouT2 OouT3 ouT4 OuUT5 ouTé

MCO7XSF517
5+1 17 mQ 17 mQ 7 mQ 7 mQ 7 mQ Yes

MCOQ07XS6517

MCO8XSF421
4+1 21 mQ 21 mQ 8 mQ 8 mQ Not connected Yes

MCO08XS6421
MC10XS6200 2+1 Not connected Not connected 10 mQ 10 mQ Not connected Yes
MC10XS6225 2+1 25 mQ Not connected 10 mQ Not connected Not connected Yes
MC10XS6325 3+1 25 mQ Not connected 10 mQ 10 mQ Not connected Yes

MC17XSF400
4+1 17 mQ 17 mQ 17 mQ 17 mQ Not connected Yes

MC17XS6400

MC17XSF500
5+1 17 mQ 17 mQ 17 mQ 17 mQ 17 mQ Yes

MC17XS6500
MC25XSF300 3+1 25 mQ 25 mQ 25 mQ Not connected Not connected Yes

MC40XSF500
5+1 40 mQ 40 mQ 40 mQ 40 mQ 40 mQ Yes

MC40XS6500
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2.3 Supported MCUs

The GendeXtremeSwitch component supports the MCUs listed in Table 2. The listed MCUs are a subset of MCUs supported by Processor
Expert for Kinetis using the logic device driver (LDD) layer.

Compatibility with other MCUs and MCU boards depends on their peripherals and pin connections.

Table 2. Supported MCUs

Supported MCUs KDS examples Limitations

FRDM-KL25Z Yes Yes

FRDM-K64F Yes Supports only one device (1 CS pin). No support for direct inputs.
FRDM-KV10Z Yes Supports only one device (1 CS pin). No support for monitoring (CSNS and

CSNS_SYNC not connected).

24 Possible Freedom board settings

The FRDM-17XSF5-EVB evaluation board features the MC17XSF500, a member of NXP's 12XSF high-side switch products family. The
board incorporates the following:

+ up to five outputs with freewheeling diode protection and LED indicators

» output for external smart power switch control output

» on-board voltage regulator and level shifter (from 3.3 V to 5.0 V logic) and switch to enable operation of up to four boards in parallel
with separate chip-select pins (parallel SPI operation)

Figure 1 shows a typical FRDM-17XSF5-EVB configuration. The eXtreme switch expansion board is mounted on top of a FRDM-KL25Z
board. The green and black connectors on the left are for power supplies. The green connector on the right connects to the load.

Figure 1. Typical FRDM-17XSF5-EVB configuration
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3 The Gend4eXtremeSwitch component

The GendeXtremeSwitch component is located under the Components folder in the Processor Expert active projects window (see
Figure 2). The functionality of this component depends on the component property settings assigned through Processor Expert.

4 = Components
. [= Referenced_Components
a @ G4x51:Gend eXtremeSwitch
@J RSTEPinl:BitIO_LDD
@ CLEL:PWM_LDD
%J SYMCPinl:Extlnt_LDD
4 SPI_Devicel:5PI_Device
8 CSpinl:Bitl0_LDD
H Init
H| Deinit
M GetQuickStatus
M GetChannelStatus
M GetDeviceStatus
M GetlOStatus
M ReadRegister
H] WriteRegister
H FeedWatchdog
M| SetOutputState
I SetPWMDuty
H SetPWMDutyValues
H SetGPWMDuty
H| SetPWMControl
H| IncrementalPWhMControl
M| SetOCHIOnDemand
¥ OLLEDTrig
H SetOLOFF
H SetDirectinput
H SetDirectinputValues
M| SetBxtClockState
M ConfigureMonitaring
M| GetSenseValue
I G4X51_OnMeasurementSynchronization

Figure 2. Gend4eXtremeSwitch Processor Expert component

The Gend4eXtremeSwitch component includes a Help function, which can be accessed by right-clicking on G4XS1:Gen4eXtremeSwitch
in the component tree. The Help on Component window provides information on all the component’s properties and methods. Access
the Typical Usage section to view examples showing how to work with API methods.
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3.1 Component settings

Selecting a component in the component tree provides access to the component’s properties in the Component Inspector. These
properties determine the component’s general settings and its behavior after initialization. Application code can later change some of these

properties using the provided API.

See Figure 3 and the associated text for a definition of the available properties.

Component Name
SPI Configuration
4 Global Configuration
RSTE Pin
External Clock Frequency
CLK Pin
Watchdog Timeout
Direct Input Control
F] Current, Voltage and Temperature Sensing
ADC Link
ADC Conversion Time
C5M5 Function
CSMS Pin
F] CSNS Synchronization
CSMS SYMC Link
CSMS SYMC Pin
4 Devices
4 Devicel
Device Model
S0A Mode
Overternperature Warning Threshold
HID Selection
QOCHI Type
Global PWM Duty Cycle
4 Channels
a Qutputl
Fi PWM Output Control
Global PWM
Channel Duty Cycle
Phase Selection
Pulse Skipping
Slew Rate Prescaler
Output Initial State
Direct Input Control
Fi Open Load
Open Load LED
OLON Deglitch Time
4 Owercurrent
OCLO Threshold
Advanced Current Sensing Mod
Shert OCHI
Mo OCHI
Qutput?
Qutput3
Qutputd
Qutput5
Qutputt
Auto Initialization

PTC12/TPM_CLEING

50000 ol
PTC3/LLWU_P7/UART1_RX/TPMO_...
32 ms

Disabled

Enabled

Al

4807692 ps

Temperature
ADCO_SE12/TSI_CH7/PTB2/12C0_...
Walid

Kinetis/Extlnt_LDD
PTD4/LLWU_P14/5PIL_PCS0/UART...
1

Sets conversion time,
4,768 ps

MC1TXSF500
Single read
115°C
Disabled
Default

0 b

Enabled

Dizabled

0 D
e

Disabled

Disabled
64 us

Low
Disabled
Dizabled
Disabled
Disabled
Disabled
Disabled
Dizabled
Disabled
yes

Channel disabled.
Channel disabled.
Channel disabled.
Channel disabled.
Channel disabled.

Figure 3. Gen4eXtremeSwitch component properties
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SPI Configuration — Configures SPI communication with devices. Two configurations are supported:

Parallel SPI — Specifies the SPI mode as Parallel SPI (common MISO, MOSI, SCLK, separate CS pins) with common RST, CLK,
CSNS and CSNS SYNC pins. For parallel SPI applications, each with its own set of SPI pins, additional instances of this component
must be included.

Daisy Chain SPI — Specifies the SPI mode as daisy chain SPI. Devices connected in daisy chain (the MISO of the first device is
connected to the MOSI of the second device, and so forth, common CS pin) with common RST, CLK, CSNS and CSNS SYNC pins.
Daisy chain SPI with these pins separated is not supported. This configuration does not support the FRDM-17XSF5-EVB.

Global Configuration — Configures shared settings for all channels on all devices

RSTB Pin — Selects the pin that initializes the device configuration and fault registers (when high). This pin also places the device in
a low-current Sleep mode (low).

External Clock Frequency — Selects the PWM clock in Hz. Admissible frequency range is 25.6 kHz to 102.4 kHz. The frequency
entered is divided by 256 when the device is in normal operating mode.

CLK Pin — Selects the reference PWM clock, which is divided by 256 when the device is in normal operating mode

Watchdog Timeout — Specifies the timeout period used to detect a loss of SPI communication. An SPI communication fault is
detected if the WD bit is not toggled with each SPI message or if the WD timeout is reached. If a SPI communication error occurs, the
device is switched into fail mode. Shorter (32 ms) or longer (128 ms) WD timeouts can be used depending on the number of connected
devices. For more devices, use longer WD timeouts.

Direct Input Control — Contains pins used as direct input pins IN1 to IN4. Direct input pins are used to directly control the
corresponding channel in fail mode. During normal mode, SPI programming can be used to enable the input control pins to control
the outputs.

Current, Voltage and Temperature Sensing — Provides settings for feedback measurement. The analog feedback circuit provides
load and device diagnostics during normal mode. The feedback monitor provides a current proportional to the current of the selected
output, a voltage proportional to the battery supply voltage or the output voltage of the temperature sensor that monitors the average
control die temperature. Settings include AD conversion time, feedback monitor functions and sensing synchronization.

Devices — Properties related to the number of devices connected to the MCU. Each device has its own set of properties.

Device Model — Model of the eXtreme Switch device. The number of displayed outputs depends on this property.
SOA Mode — Specifies the reading mode of the device

— Single Read — Specifies that the programmed SO address is used for a single read command. After the reading, the SO address
returns to quick status register.

— All Reads - Specifies that the programmed SO address is used for the next and all further read commands until a new SO
address is programmed.

Overtemperature Warning Threshold — Specifies the maximum safe operating temperature in Celsius for the power transistors. A
temperature sensor is located on each power transistor to protect the transistor and to provide SPI status monitoring. When the
overtemperature warning threshold is exceeded, the outputs remain in their current state but an overtemperature warning is reported.
The overtemperature threshold can be set low (115 °C) or high (135 °C).

HID Selection — Enables/disables smart high-intensity discharge (HID). The smart overcurrent window control feature turns on an
HID ballast even when the power-on reset time is long. Smart HID can be enabled/disabled for all channels, channel 3 only, or
channels 3 and 4.

OCHI Type — Selects the OCHI type. To minimize the electro-thermal stress inside the device when a short-circuit occurs, the OCHIx
levels can be either dynamically adjusted with respect to the control die temperature or evaluated during the OFF-to-ON output
transition, depending on the output voltage. For output protection, the OCHI level can be set to depend on the control die temperature,
the output voltage or both temperature and voltage.

Global PWM Duty Cycle — In addition to the individual PWM register, each channel can be assigned independently to a global PWM
register. When a channel is assigned to global PWM, the global PWM duty cycle is applied but the switching phase, the prescaler and
the pulse skipping conform to the corresponding output channel setting.

Depending on the selected device model, all available outputs are displayed and can be enabled/disabled individually. Each output has
its own set of properties. Not all features are available for all output channels. The properties are grouped as follows:

PWM Output Control — Properties influencing the PWM output signal

—  Global PWM - In addition to the individual PWM register, each channel can be assigned independently to a global PWM register.
When a channel is assigned to global PWM, the global PWM duty cycle is applied but the switching phase, the prescaler and the
pulse skipping conform to the corresponding output channel setting.

— Channel Duty Cycle — Specifies the duty cycle of the PWM when the channel is controlled individually

Gen4eXtremeSwitch Processor Expert component, Rev. 1.0
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— Phase Selection — Selects the phase assignment of the output channel

— Pulse Skipping — Enables/disables the pulse skipping feature. Due to the output pulse shaping feature and the resulting
switching delay time of the smart switches, the device cannot generate duty cycles close to 0 or respectively 100 percent. When
enabled, the pulse skipping feature interpolates the output duty cycle range in normal mode.

— Slew Rate prescaler — Depending on the programming of the prescaler setting register, the switching speeds of the outputs are
adjusted to the output frequency range of each channel.

— Output Initial State — Selects the state of the output (on or off) after initialization

» Direct Input Control — If enabled, output is assigned to direct input pin control. To use direct input pin control, enable the Direct Input
Control property in the global configuration part of the component and set up the pins. The channel output initial state has to be set
to On in properties or in code by method SetOutputState.

» Open Load — Properties related to the open load detection features

— Open Load LED - Enables/disables a special low current detection mode that detects small load currents (for example, an LED)
in the on state of the switch.
— OLON Deglitch Time — When an open load is detected, the output remains in the on state. To meet the requirements of different
load types, the deglitch time of the open load in the on state can be controlled individually for each output. Short deglitch times
(64 us) for bulbs and long deglitch time (2 ms, converter mode) are implemented.
» Overcurrent — Properties related to overcurrent protection. This feature guards against an ultra-low resistive short-circuit condition
resulting from a smart overcurrent profile and severe short-circuit protection.

— OCLO Threshold — The static overcurrent threshold can be programmed individually for each output in two levels (low, high) to
adapt low duty cycle dimming and a variety of loads.
—  Short OCHI — The length of the OCHI windows can be shortened by a factor of 2 to accelerate the availability of the CSNS
diagnosis and to reduce the potential stress inside the switch during an overload condition.
— No OCHI - To accelerate the availability of the CSNS diagnosis, the switch on process of an output can be done without an OCHI
window.
» Current Sensing — Properties related to current monitoring features

— Advance Current Sensing Mode — An advanced current sense mode (ACM) diagnoses LED loads in normal mode and
improves current sense accuracy for low current loads. In the ACM mode, the offset sign of the current sense amplifier is toggled
on every CSNS SYNCB rising edge. The error amplifier offset contributes to the CSNS error. This contribution can be fully
eliminated from the measurement result by averaging each set of two sequential current sense measurements. In addition, the
Advanced Current sensing Mode divides the selected OCLO threshold by 2.

Auto Initialization - Selects whether component initialization is automatically called from within the CPU component initialization function
PE_low_level_init or whether the user is responsible for calling the initialization method.

GendeXtremeSwitch Processor Expert component, Rev. 1.0
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The Gen4eXtremeSwitch component

Gen4eXtremeSwitch uses the SPlI communication protocol to communicate with the MCU. This protocol is implemented by the
SPIMaster_LDD component located under Referenced Components in the Processor Expert Components panel (Figure 2).
SPIMaster_LDD does not handle arbitration for more simultaneous communication requests on the SPI bus. This functionality is
implemented by the SPI_Device component, which is exclusively inherited by Gen4eXtremeSwitch component. The component
supports up to four devices connected in parallel with an SPI_Device component configured for each device.

In SPIMaster_LDD, the MISO, MOSI and CLK pins and timing settings have to be properly selected according to 12XSF/12XS6 datasheet
recommendations (Figure 4). The maximum admissible communication frequency is 5 MHz.

Properties

Mame

Methods | Events

Component name
Device
Interrupt service/event

Input interrupt

Input interrupt priority
Output interrupt

Output interrupt priority

Settings

Input pin
A Pin
Pin signal
Output pin
A Pin
Pin signal
Clock pin
A Pin
Pin signal
Chip select list
Attribute set list
Attribute set 0
Width
MSE first
Clock polarity
Clock phase

Parity

Chip select toggling

Clock rate index
Clock rate
HW input buffer size
HW input watermark
Receiver DMA
HW output buffer size
HW output watermark
Transmitter DMA

Value

Sh1
SPIO
Enabled

medium pricrity

medium pricrity

Enabled
PTD3/SPI0_MISO/UARTZ_TX/TPMO_CH3/SPI0_MOSI

Enabled
PTDZ/SPI0_MOSLYUART2_RX/TPMO_CH2/SPID_MISO

ADCO_SESh/PTDL/SPI0_SCK/TPMO_CHL

Disabled
1
1
Disabled

Details

SP10

INT_5PI0
2
INT_SPID
2

PTD3/5PI0_MISO/UARTZ_T.

PTD2/SPID_MOSLYUARTZ_R

ADCO_SESb/PTDL/SPI0_SCE

Controlled by SPI_Device cc

1 MHz

Figure 4. The SPI configuration (pins for FRDM-KL25Z are shown)
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The CSB (chip select) pin must be set separately in the BitlO_LDD component exclusively inherited by SPI_Device (see Figure 5).
Because of component implementation limitations, the user must initialize the CSB pin value to 1 as specified in the datasheets.

5. Compenents - X5F_KL25Z_20LEDs &3 = =

- = OS5 -
4 [ Processors
. € Cpu:MKL257128VLKS
4 [ Components
4 [ Referenced_Components
- 63 TUL:TimerUnit_LDD
3 @ SML:5PIMaster_LDD[5PImaster]
4 B3 XSFL:32VeXtremeSwitch
@J RSTBPinl:BitIO_LDD
o CLKL:PWM_LDD
4 SPI_Devicel:5PI_Device
% CSpinl:Bitl0_LDD
4 SPI_Device2:5PI_Device
B CSpin2:Bitl0_LDD
] Init
®] Deinit
M| GetQuickStatus
M| GetChannelStatus
M GetDeviceStatus
M GetlOStatus .

m

B8 CSpinl:Bitl0_LDD

Figure 5. SPI Chip Select configuration
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3.3 Component API

The Gen4eXtremeSwitch component provides API functions allowing application code to dynamically configure a device in real-time. To
view the available methods and events, click to expand the component in the Component folder of the Processor Expert Components

panel (see Figure 2).

In Processor Expert, methods and events are marked to indicate which of them are included when code is generated. A tick mark beside
a method/event indicates that the item is generated; A cross indicates that the item is not generated. Any of these settings can be saved
in the Processor Expert Inspector panel. Methods/events with grey text are always generated because they are needed for proper
functionality. This forced behavior depends on various combinations of component property settings. For a summarization of available API
methods and events and their descriptions, see Table 3.

Table 3. Gen4eXtremeSwitch component API

Method/Event Description
Init Initializes the device according to the component properties
Deinit Deinitializes the device (puts the device in sleep mode)
GetQuickStatus Returns current status of the device
GetChannelStatus Gets fault information for all available channels
GetDeviceStatus Gets information on the status of the device
GetlOStatus Gets information on the 1/O of the device
ReadRegister Reads the value of the given register via SPI
WriteRegister Writes the value to the given register via SPI
FeedWatchdog Toggles the watchdog bit in all devices to avoid watchdog timeout
SetOutputState Turns on/off channels of the device
SetPWMDuty Sets PWM duty for the specified channel
SetPWMDutyValues Sets PWM duty for all available channels of the device
SetGPWMDuty Sets Global PWM duty cycle value
SetPWMControl Sets PWM output to Global or individual PWM control

IncrementalPWMControl

Sets LSB step by which the duty cycle is incremented or decremented with every call of this method

SetOCHIOnDemand

Enables the OCHI On Demand (over current high on demand) feature on corresponding channel

OLLEDTrig

Triggers the Open load functionality for LED

SetOLOFF

Enables the OLOFF (open load detection in off state) for the corresponding channel

SetDirectinput

Sets target pin INx high/low voltage The direct input is used to directly control corresponding channel in Fail mode

SetDirectinputValues

Sets target pin INx high/low voltage for all channels simultaneously. The direct input is used to directly control the
corresponding channel in fail mode

SetExtClockState

Enables/disables the external clock timer

ConfigureMonitoring

Configures CSNS pin output; sets monitored parameter and synchronization

GetSenseValue

Configures monitoring of current, voltage or temperature on the CSNS pin and returns the corresponding value
from the ADC

OnMeasurementSynchronization

Invoked when a measurement synchronization trigger occurs

Gen4eXtremeSwitch Processor Expert component, Rev. 1.0
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3.4 Utilized components

The Gen4eXtremeSwitch consists of the Gen4eXtremeSwitch component and a set of referenced components. Figure 6 illustrates these
components and their relationship to each other. A description of the components appears immediately below Figure 6. The functionality
of the Gen4eXtremeSwitch depends on these components to support functions such as communication and control.

MIS0, MOST, SCLK GendeXtremeSwitch Component CSNS
5PI_Device
<pr M Lob Current )
b1 “— BIRIO_LDO Sensing | ADC_LDD
RST <+— BitIO_LDD Bfuﬂt_LDD +—— CEMNE SYMNC
IN1..4 «—— BitIo_LDD PWM_LDD » TimerUnit_LDD—— CLK

Figure 6. Components used by the Gen4eXtremeSwitch component

The components used by Gen4eXtremeSwitch (sorted as in the component tree) are as follows:
Referenced components

+ SM1:SPIMaster_LDD — Standard SPI communication model; referenced by SPI_Device
* TU1:TimerUnit_LDD — Referenced by CLK1:PWM_LDD
+ AD1:ADC_LDD - Current sensing
G4XS1:GendeXtremeSwitch — configures 12XSF/12XS6 features
+ SPI_Device1:SPI_Device — Adds bus allocation for SPI communication
— CSPin1:BitlO_LDD — Software chip select
+ RSTBPin1:BitlO_LDD — Reset pin
* CLK1:PWM_LDD - PWM clock generation

* IN1Pin1:BitlO_LDD - direct input pin; same for IN2Pin1, IN3Pin1 and IN4Pin1
* SYNCPin1:ExInt_LDD - synchronization trigger for ADC

GendeXtremeSwitch Processor Expert component, Rev. 1.0
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4 Installing the Processor Expert software

This chapter describes the installation of Kinetis Design Studio and the use of Processor Expert for application development. Processor
Expert software is available as part of the CodeWarrior Development Studio for Microcontrollers, Kinetis Design Studio or as an
Eclipse-based plug-in for installation into an independent Eclipse environment (Microcontroller Driver Suite). For more information about
Processor Expert refer to this link: www.nxp.com/ProcessorExpert.

4.1 Installing Kinetis Design Studio

This procedure explains how to obtain and install the latest version of Kinetis Design Studio (version 3.0.0 in this guide). The procedure
for CodeWarrior installation is similar.

NOTE
The component and some examples in the component package are intended for CodeWarrior 10.6
(or above) and Kinetis Design Studio 3.0.0 (and above). If CodeWarrior 10.6 and Kinetis Design
Studio 3.0.0 are already installed on the system, skip this section.

1. Obtain the latest Kinetis Design Studio installer file from the NXP website here: www.nxp.com/KDS

2.Run the executable file and follow the instructions.

4.2 Downloading the components and example projects

The examples used in this section are based on a pre-configured Kinetis Design Studio project. To download the project and its associated
components:

1. Go to the NXP website www.nxp.com/GEN4-EXTREMESWITCH-PEXPERT.
2. Download the zip file containing components and example projects.
3. Unzip the downloaded file and check to see that the folder contains the files listed in Table 4.

Table 4. Downloaded zip file contents

Folder Name Folder Contents
Component Processor Expert components folder
Gen4eXtremeSwitch_Bxxx.PEupd Gen4eXtremeSwitch component update file
SPI_Device_Bxxx.PEupd SPI_Device component update file
KDS_Examples Example projects folder for Kinetis Design Studio

Demo project that demonstrates how to use the FreeMASTER application along with the Gen4eXtremeSwitch

G4XS_KL25Z_FreeMASTER component to drive a 32 V eXtreme Switch device and a FRDM-KL25Z

Example project that demonstrates the use of incremental PWM feature of a 32 V eXtreme Switch with a

G4XS_KL25Z_IncrementalPWM FRDM-KL257

Example project that demonstrates how to configure feedback monitoring and how to get measured values

G4XS_KL25Z_Measurement with 3 FRDM-KL257

Example project that demonstrates how to parse and interpret status data using the Gen4eXtremeSwitch

G4XS_KL25Z_ ParseStatusData component with a FRDM-KL25Z

Example project that demonstrates how to set the PWM duty value of selected channels on multiple devices

G4XS_KL25Z_SetPWMDutyParallel | ~5TFCPRICE O

Example project that demonstrates how to set the PWM duty value for selected channels on single device

G4XS_KL25Z_SetPWMDutySingle with FRDM-KL 252

Demo project that demonstrates the use of the FreeMASTER application along with a Gend4eXtremeSwitch

(G4XS_K64F_FreeMASTER component to drive a 32 V eXtreme Switch device and a FRDM-K64F

Example project that demonstrates how to use the incremental PWM feature of a 32 V eXtreme Switch with a

G4XS_K64F_IncrementalPWM FRDM-K64F

Example project that demonstrates how to configure feedback monitoring and how to get measured values

G4XS_K64F_Measurement with FRDM-K64F.

Example project that demonstrates how to parse and interpret status data using the Gen4eXtremeSwitch

G4XS_K64F_ParseStatusData component with a FRDM-K64F

Gen4eXtremeSwitch Processor Expert component, Rev. 1.0
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Table 4. Downloaded zip file contents

Folder Name Folder Contents

. Example project that demonstrates how to set the PWM duty value of selected channels on a single device
G4XS_K64F_SetPWMDutySingle with a FRDM-K64F
G4XS KV10Z IncrementalPWM Example project that demonstrates how to use the incremental PWM feature of a 32 V eXtreme Switch with a

- - FRDM-KV10Z
G4XS_KV10Z_ParseStatusData Example projgct that demonstrates how to parse and interpret status data using the Gen4eXtremeSwitch
component with a FRDM-KV10Z
. Example project that demonstrates how to set the PWM duty value for selected channels on a single device

G4XS_KV10Z_SetPWMDutySingle with a FRDM-KV10Z

4.2.1 Importing the Gen4eXtremeSwitch component into the Processor Expert
library

The following steps show how to import the Gen4eXtremeSwitch component (downloaded as part of the zip file) into Kinetis Design Studio.
The process for CodeWarrior is similar.

1. Launch Kinetis Design Studio. When the Kinetis Design Studio IDE opens, go to the menu bar and click Processor Expert ->
Import Component(s).

2.In the pop-up window, locate the component file (.PEupd) in the folder Gen4eXtremeSwitch_PEx_SW\Components. Select the
GendeXtremeSwitch _bxxxx.PEupd and SPI_Device_bxxxx.PEupd files. Then click Open (see Figure 7).

e FiEEL

File Edit Source Refactor MNavigate Search Project Run Window Help
M- - viw | { R e Show Views i v Ay - - -
- Hide Views
; = & = o =
L7 Project Explorer 2 = | 8 I Import Component(s) 8 % Component Inspector 232

Organize » Mew folder

. 532K144_SDKOL_Repository Mame Date modified Type

| GendextremeSwitch_b160430.PEupd 3/24/2016 13:23 PEUPD File

= Libraries > e e >
|| SPI_Device_B1401.PEupd 10/13/2014 16:16 PEUPD File

f& Homegroup
5. Components &3
1M Computer
.‘;. Primary (C:)
== Removable Disk (E:)

€l Network

- 4 Tl 3

File name: "Gend extremeSwitch_b160430.PEupd” "SPI_Device B140 - |Processor Expert Update packar v|

l Open |vl | Cancel |

Figure 7. Import the Gen4eXtremeSwitch components

3. Select a repository to import the components into. Then click OK.

* In CodeWarrior, components are imported to a predefined default repository.
* In Kinetis Design Studio, you are offered a choice to select a repository.
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4. If the import is successful, the Gen4eXtremeSwitch component appears in Components Library -> Software -> User
Component (see Figure 8). The component is now ready to use.

% Compenent Inspector % Compoenents Library 52 | 0= Outline (@) Make Target [E] Task List

Alphabetical | Categories . Processors | Board Configurations

T All repositories = | |App|icable to project v|

Component Description
. [= Kinetis
4 [= My Components
4 [ Software
4 [ User Components

[x GendeXtremeSwitch

A SPI Device Communication with 5PI device placed on 5PI bus
|
3 ThreePhaseMotorControl  Three-Phase BLDC Motor Control

I

@ ThreePhasePredriver Three Phase FET Pre-Driver GD3000,/MC33937 /M C34937

Processor Expert support for 32V ektremeSwitch devices,

Figure 8. Gend4eXtremeSwitch component location after importing to Kinetis Design Studio

4.2.2 Importing an example project

The following steps show how to import an example project (downloaded with the zip file) into Kinetis Design Studio. The process for
CodeWarrior is similar.

1.In the Kinetis Design Studio menu bar, click File -> Import... In the pop-up window, select General -> Existing Projects into
Workspace and click Next.

Edit Source Refactor Mavigate Search Project Run ProcessorExpert Window Help

New AeShifteN > o G v de v Qv Qv G vi® (o ! g e e
Open File...
= B %y ComponentInspector %y Components Liar
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+5
\-I
Create new projects from an archive file or directory. E E
Ctrl+Shift+5
Revert
Select an impart source:
Move... type filter text
Rename... F2 2 = General T
Refresh F5 [ Archive File
Convert Line Delimiters To > = Existing Projects into Workspace| 9
=, Flle System i
Print... Ctrl+P [C] Preferences i
Switch Workspace > & GG ; E
(= Component Development Environment
Restart
(= CVS
= — (= Install
1| bepork- (= Processor Expert
Properties Alt+Enter (= Project of Projects
(= Remote Systems
1 shb_test_Debug_PNElsunch [shb_test..] = RPM
2 main.c [shb_test k27z/source] Run/Mehiin =
3 fsl_dspi.c [shb_test_k64f/drivers]
4 spi_aml.c [shb_test_kb4f/source/...]
Exit ~
‘/?) B MNext > Finish Cancel

Figure 9. Importing an example file
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2. Click Browse and locate the folder where the unzipped example files are located. Find the folder
GendeXtremeSwitch_PEx_SW\KDS_Examples and select a project to import. Then click OK.

3. With the project now loaded in the Select root directory box, click on the Copy projects into workspace check box. Then click
Finish. The project is now in the Kinetis Design Studio workspace where it can be built and run.

4.3 Creating a new project with Processor Expert and the
GendeXtremeSwitch component

If you elect not to use the example projects, the following instructions describe how to create and setup a new project using the
Gen4eXtremeSwitch component. If you do not have Gen4eXtremeSwitch components in the Processor Expert Library, follow the steps in
Section 4.2.1, Importing the Gen4eXtremeSwitch component into the Processor Expert library, page 14.

The following procedure describes how to create a new project using Kinetis Design Studio. The process for CodeWarrior is similar.

1.1n the Kinetis Design Studio menu bar, select File -> New -> Kinetis Project. When the New Kinetis Project dialog box opens,
enter a project name into the text box and then click Next.

2.In the Devices dialog box, select the MCU class for the appropriate MCU. In Figure 10 MKL25Z128xxxx4 has been selected.
Then click Next.

3. In the Rapid Application Development dialog box, make sure that the Processor Expert option is selected. Then click Next.

4.In the Processor Expert Target Compiler dialog box, select a compiler (GNU C Compiler in Figure 10) and click Finish.

# New Kinetis Project = = ]
Devices % Mew Kinetis Project Lﬂ&”
Select the derivative you would like to use Rapid Application Development % New Kinetis Project o=
SDK, P Expert .
Processor to be used: K, Processor Bxpe Processor Expert Target Compiler
type filter text Target compiler
Boards Kinetis SDK | None
4 Processors Target compiler
-+ Kinetis E - . GNU C Compiler
Kinetis K Environment variable TAR ARM C Compiler
4 KinetisL Absolute path Keil ARM C/C++ Compiler
MEKLOx
- MKLLx
. KL24Z (48 MHz)
4K 48 hH Start with perspective designed for
MEL2571 28:00¢4 Hardware cenfiguration (pin musin)
MKL25Z3 20k @ Use current perspective
MEL257Z64:004

Initialize all peripherals

Creates project for MKL2571 280 derivative Project Mode

Linked
@ Standalone
If this project is expected to use the Kinetis 5D

Kinetis SDK into this tool using Help -> Install
your Kinetis 5DK folder to find the appropriate]

@ <Back f  Next>

Enable Processor Expert in the project for MC
initialization.

= P T b
@ <Back | mea» p

MNext = I Finish u‘ Cancel ‘

Figure 10. Selecting a device, the Rapid Application Development options and compiler

5. Figure 11 shows the Projects Explorer panel and the Components panel after the project has been successfully created. Before
the project can be built and run, add the Gen4eXtremeSwitch component (imported in Section 4.2.2, Importing an example
project, page 15) into the project. Section 4.3.1, Adding a Gen4eXtremeSwitch component into the project, page 17 outlines this
procedure.
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L’y Project Explorer &3 = 8
== =
|5 Example
5. Components - Example &1 = 0
SHCE T
4 [~ Generator_Configurations
@i FLASH
> (= 05s

4 [= Processors

. & Cpu:MKL257128VLK4
- (= Components
. [= PDD

Figure 11. Project Explorer and Components panels with project created

4.3.1 Adding a Gen4eXtremeSwitch component into the project

1. Find the Gen4eXtremeSwitch component in the Components Library and add it into the project (see Figure 12). The
Gen4deXtremeSwitch component is located in the workspace directory selected when importing the component.

File Edit Source Refactor Mavigate Search Project Run  Processor Expert Window Help

= B RN SR ARACRACREE R RA A’ D ED_ RSt & el e
I Project Explorer &3 — <'}=={> T =08 % *Component Inspector - SM1 % Components Library &2 5= Outline (&) Make Target [E] Task List
. =% Example
Alphabetical | Categories . Processors| Board Configurations
T |AII repositories - | |Applicable to project v|
Component Description
- = Kinetis
5. Components - Example &3 S B Y= 8 4 (= My Components
4 [~ Generator_Configurations 4 & Software
i FLASH ; i
. Processor Expert support for 32V eXtremeSwitch devices.
: = OS5
# (& Processors 3 SPIDevi C ication with SPI device placed on SPIb
| & CpuMKL2SZL28VLKS | Device ommunication wi evice placed on us
4 = Components @ThreephaseMotorControl Three-Fhaze BLDC Motor Control
= P @ ThreePhasePredriver Three Phase FET Pre-Driver GD3000,/MC33937/MC34937
- [= Referenced_Components

. €3 G4XSL:GendeXtremeSwitch

. (= PDD

Figure 12. Add the Gen4eXtremeSwitch component to the project

2. To view the Component Inspector options, double-click on the Gen4eXtremeSwitch component in the Components panel.
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4.4  Setting up the project

Once the new project has been created and the Gen4eXtremeSwitch component has been added into it, the component properties in the
project must be set up. Make sure to read Section 3.1, Component settings, page 6, which describes the component’s capabilities and
what must be done to configure its properties.

Gen4eXtremeSwitch uses several components (see Figure 13). Configure all the components in the following order:
1. Set up the referenced SPI_Master_LDD component.
2.Set up CS pin under the inherited SPI_Device component.
3. Set up the inherited Gen4eXtremeSwitch component.

5. Components - Example &2 - % ® ¥ = 8

4 (= Generator_Configurations -
i FLASH

> = 05s
a (= Processors

. 4 Cpu:MKL257128VLK4
a® Components

4 E; Referenced_Components

- B3] TUL:TimerUnit_LDD

. 5] SM1:SPIMaster LDD[SPImaster]
F] a o i

m

% RSTEPinl:BitIO_LDD
g CLKL:PWM_LDD
4 SPI_Devicel:SPI Device
%) Cspinl:Bitl0 LDD
H Init
H Deinit
M GetQuickStatus
M| GetChannelStatus
M GetDeviceStatus
M| GetlOStatus -

Figure 13. Setting up the components

4.5 Generating driver source code

Once you have completed configuring the components, the application is ready to generate the driver code. The process is as follows:
1. Click on the Generate Processor Expert Code icon in the upper right corner of the Components panel. (See Figure 14)

5. Components - Example 23 =G = = 8 [ Project Explorer &3 = t}| ¥ =0
4 (= Generator_Configurations 4|\ Example
i FLASH [l Includes
> = 0Ss + = Documentation
4 (= Processors + = Generated Code
> Q Cpu:MKL2571 28VLKd » = Project_Settings
4 (= Components 4 (= Sources

» |.¢] Events.c
. [n] Events.h

- |.g) main.c

. = Referenced_Components
. B3 G4X51:GendeXtremeSwitch
. (= PDD

. (= Static_Code
% ProcessorExpert.pe
|=| Projectinfo.xml
Figure 14. Generating the driver code and code location

2. The driver code for the device is generated into the Generated_Code folder in the Project Explorer panel. The component only
generates the driver code. It does not generate application code (see Figure 14)
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4.6 Writing the application code

All of the application code must reside in the Sources folder in the project directory. The code in main.c and Events.c can be modified,
but take care to retain the original comments related to usage directions.

To add a component method into the application source code:
1.1n the Components panel for the project, click on Components. Find the desired method to add to the code.
2.Drag and drop the method directly into the source code panel.

3. Add the appropriate parameters to the method. Hovering the mouse over the method displays a list of the required parameters.

For example, open the Gen4eXtremeSwitch component method list, drag and drop SetPWMDuty into main.c and add the necessary
parameters. (See Figure 15).

L Project Explorer &7 =5 =0 lg| “mainc &2 = ml
4 [ Eample /* Including nesded modules to compile this module/procedure */
[m)! Includes #include "Cpu.h”

#include "Events.h”
#include "G4XS1.h"
#include "RSTEPinl.h"

(= Documentation
= Generated_Code

(= Project Settings #include "CLK1.h"
4 (= Sources #include "SPT_Devicel.h”
Lg| Events.c #include "CSpinl.h”
. i Eventeh #include "
T #include
- = /* Includ
(= Static_Code #include
%y ProcessorExpert.pe #include
[ Projectlnfoxml #include
#include "I0_Map
B e Sh® v = o /* User includes (#include below this line is not maintained by Processor Expert)
4 ﬁGdXSl:Genda(tremeSW\tch - /*1lint -save -e97@ Disable MISRA rule (6.3) checking. */
] RSTBPIn:BII0_LDD int main(void) ble MISRA rule (6.3) checki 2
B CLKLPWM LD ; lint -restore Enable MISRA rule (6.3) checking.
» Bl SP1 Devicel:SPI Device /* Write your local variable definiti
H Init
H Deinit /*=* Processor Expert internal ini MOVE THIS CODE!!!
i GetQuickStatus PE low level init();

[ GetChannelStatus
[ GetDeviceStatus
il GetlOStatus
A ReadRegister
T WriteRegister

ite your code here */
r example: for(;;)

53 1)
GAXS1 SetPWMDuty(didxDEVI, @, 128);

1 be deleted during code gene

B FecdWatchdog J=*% RTOS tup code. Macr fined by the RTOS component. D(
Fi SetQutputState #ifdef PEX_RTOS_START

T SetPWMDui PEX_RTOS_START(); /* Startup of the selected RTOS. Macro is de
B SetPWMDutyValues #endif

Figure 15. Adding component methods

Hovering the mouse over any of the methods displays a description of the method, including a list of required parameters.

The Gen4eXtremeSwitch component encompasses a Help feature that describes component properties, methods and typical usage. To
invoke the Help feature, do the following:

1.1n the Components view, right-click Gen4eXtremeSwitch component and select Help on Component.
2. A web page with the Help information is displayed.
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4.6.1 Compiling, downloading and debugging

To compile a project, click on the compile icon in the tool bar (see Figure 16).

File Edit Source Refactor Navigate Search  Project Run Processor Expert Window Help

= :;.;:..vm'-w_i .&.‘,-_',:-.{:.,..pv

Figure 16. Compiling the project

The process for downloading an application onto a board may differ according to the MCU board used. For any questions, see the Kinetis
Design Studio or CodeWarrior user's guide.

To download and debug with a FRDM-KL25Z MCU board, do the following:

1. Click the arrow next to the debug icon in the menu bar and select Debug Configurations...

2. In the Debug Configurations dialog box, click Example_Debug_PNE under GDB PEMicro Interface Debugging (see
Figure 17).

3. Make sure that C/C++ Application contains a path to the .elf file of the project (see Figure 17).

# Debug Configurations LE-J
Create, manage, and run configurations @
EIEEN Mame: Example_Debug PNE
type filter text [El Main | %5 Debugger | b= Startup % Source| [C] Commen

[T] C/C++ Application
== Project:
£ | C/C++ Attach to Application

[T] C/C++ Postmortem Debugger Example Browse...
[E] €/C++ Rernote Application ————————
[T] GDB Hardware Debugging Specify the number of additional EIf Files you wish to program: Generate EIf Fields

[c | GDB OpenOCD Debugging
2. GDE SEGGTR -Link Debugging Variables... | [Search Project..| [ Browse.. |
= Launch Group

C/C++ Application:
| Debug/Eample.clf |

Build (if required) before launching

Build configuration: | Use Active v|
Enable auto build _) Disable auto build
@ Use workspace settings Configure Workspace Settings...
Filter matched 16 of 28 items EEL i
‘/?3‘ [ Debug ] | Close

Figure 17. Downloading the application (a)

4. Click the Debugger tab and set the Interface option to OpenSDA Embedded Debug - USB Port. Then click the Refresh button
next to the Port setting to update the list of available USB ports (see Figure 18).

5. Make sure the Target is set to KL25Z2128M4. If not, change the target by clicking the Select Device button. In the Select Target
Device dialog box, go to Kinetis L -> KL2x -> KL25Z128M4 and confirm with the Select button.

6. Click Debug. Kinetis Design Studio downloads and launches the program onto board.
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#: Debug Configurations

Create, manage, and run configurations

2 %| B
typefilter text

[] C/C++ Application
[£] C/C++ Attach to Application
[T] C/C++ Postmortem Debugger
[£] C/C++ Remote Application
[ ] GDB Hardware Debugging
- [€] GDB OpenOCD Debugging
4 [£] GDB PEMicro Interface Debugging
[] Example_Debug_PNE
> [] GDB SEGGER J-Link Debugging
B Launch Group

Filter matched 16 of 28 items

i, Plugin has not been registered. Some functionality may not be available.

Neme: Example_Debug_PNE
] Main

Software Registration

i startup | & Source| [[] Common

Please register your software to remove this message.

PEMicro Interface Seftings

Interface: | OpenSDA Embedded Debug - USB Port ~ Icompatible Hardware

+ | Reresn |

Port: J s - Opensba (OpensDa)

Vendor: Freescale Family: KL2x
Corer

Specify P Specify Network Card IP

Additional Options

Figure 18. Downloading the application (b)
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5 References

Following are URLs where you can obtain information on related NXP products and application solutions:

Table 5. References

NXP.com Support Pages

Description

URL

MC12XSF

Product Summary Page

www.nxp.com/MC12XSF

MC12XS6

Product Summary Page

www.nxp.com/MC12XS6

FRDM-MC12XSF

Tool Summary Page

www.nxp.com/FRDM-MC12XSF

nents and example files

FRDM-KL25Z Tool Summary Page www.nxp.com/FRDM-KL25Z

FRDM-K64F Tool Summary Page www.nxp.com/FRDM-K64F

FRDM-KV10Z Tool Summary Page www.nxp.com/FRDM_KV10Z

Kinetis Design Studio Software www.nxp.com/KDS

CodeWarrior Software www.nxp.com/codewarrior

Processor Expert Software www.nxp.com/ProcessorExpert
GendeXiremeSwitch compo- | g a0 WWw.nxp.com/GEN4-EXTREMESWITCH-PEXPERT

5.1 Support

Visit www.nxp.com/support for a list of phone numbers within your region.

5.2 Warranty

Visit www.nxp.com/warranty to submit a request for tool warranty.
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